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DÖÏNG PHIM MOÂ PHOÛNG CHUYEÅN ÑOÄNG CUÛA VAÄT THEÅ 

BAÈNG PHAÀN MEÀM ÑOÀ HOÏA SOLIDWORKS  

Ngoâ Baûo 

Tröôøng Ñaïi hoïc Thuû Daàu Moät 

  

TOÙM TAÉT 

Baøi baùo naøy trình baøy moät phöông phaùp veà laøm phim moâ phoûng chuyeån ñoäng cuûa vaät 

theå. Ñoù laø söû duïng phaàn meàm ñoà hoïa SolidWorks 2009 ñeå veõ vaät theå 3 chieàu (3D), laép gheùp 

caùc vaät theå vôùi nhau thaønh moät heä thoáng nhieàu vaät vaø taïo döïng thaønh phim ñoäng phuïc vuï 

giaûng daïy vaät liù, hoùa hoïc vaø caùc moân hoïc thuoäc khoái ngaønh kĩ thuaät. Ñeå minh hoïa, taùc giaû 

trình baøy caùch döïng moät ñoaïn phim moâ phoûng dao ñoäng cuûa con laéc ñôn.  

Töø khoùa: moâ phoûng, vaät theå 3 chieàu (3D) 

*

1. Ñaët vaán ñeà 

Trong giaûng daïy vaät lí, hoùa hoïc vaø caùc 

moân hoïc thuoäc khoái ngaønh kĩõ thuaät, giaùo 

vieân thöôøng xuyeân phaûi moâ taû cho hoïc vieân 

nghe veà caùc daïng chuyeån ñoäng nhö: chuyeån 

ñoäng cuûa caùc haït electron xung quanh haït 

nhaân, dao ñoäng cuûa con laéc ñôn, chuyeån 

ñoäng cuûa caùc phaân töû hoùa chaát taùc duïng vôùi 

nhau khi phaûn öùng hoùa hoïc ñang xaûy ra, dao 

ñoäng cuûa toøa nhaø khi chòu taùc duïng cuûa gioù, 

chuyeån ñoäng cuûa ñöôøng söùc töø gaây ra moâmen 

laøm quay truïc ñoäng cô ñieän… Taát caû caùc loaïi 

chuyeån ñoäng naøy ñeàu coù theå ñöôïc moâ phoûng 

baèng phaàn meàm ñoà hoïa SolidWorks 2009. 

Khi trình chieáu baøi giaûng baèng 

Powerpoint, ta cheøn vaøo caùc ñoaïn phim moâ 

phoûng chuyeån ñoäng cuûa caáu truùc khoâng gian 

3 chieàu ñeå minh hoïa thì hieäu quaû daïy vaø hoïc 

taäp seõ cao, ngöôøi hoïc seõ thaáy thuù vò hôn, baøi 

giaûng cuûa giaùo vieân cuõng sinh ñoäng hôn.  

Trong baøi baùo naøy, chuùng toâi trình baøy 

caùch duøng SolidWorks 2009 ñeå veõ vaø döïng 

phim moâ phoûng chuyeån ñoäng cuûa heä vaät 

ñôn giaûn nhaát, ñoù laø con laéc ñôn.  

2. Veõ caùc boä phaän cuûa con laéc ñôn 

Con laéc ñôn goàm quaû caàu gaén vaøo daây 

treo vaø choát treo coá ñònh.  

 

 

 

 

 

 

 

 

 

Hình 1: Con laéc ñôn 

2.1. Khôûi ñoäng Solidworks vaø taïo 

maøn hình troáng, saün saøng ñeå veõ 

i/ File > New > Xuaát hieän hoäp thoaïi 

New SolidWorks Document nhö hình 2. 

ii/ Choïn Part (ôû hình 2) > OK > Xuaát 

hieän maøn hình laøm vieäc môùi cuûa 

SolidWorks  nhö hình 3.  

 iii/ Nhaáp chuoät traùi choïn Sketch ôû phía 

döôùi cuûa thanh Command Manager > Tieáp 
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theo choïn Sketch ôû phaàn ñaàu beân traùi cuûa 

thanh Command Manager > Xuaát hieän treân 

maøn hình goàm 3 maët phaúng vuoâng goùc 

nhau laø Top Plane, Front Plane vaø Right 

Plane > Nhaáp choïn Front Plane, 

SolidWorks môû maøn hình saün saøng ñeå veõ. 

 

 

 

 

 

 

 

Hình 2 

 

 

 

 

 

 

Hình 3 

2.2. Veõ quaû caàu vaø daây treo con laéc 

ñôn 

Böôùc 1: Veõ quaû caàu 

i/ Töø maøn hình saün saøng veõ nhö trình 

baøy ôû phaàn treân, choïn bieåu töôïng hình troøn  

( )treân thanh Command Manager > Con 

troû chuoät seõ trôû thaønh caây vieát > Ñeå muõi 

vieát vaøo goác bieåu töôïng goác toïa ñoä giöõa maøn 

hình, giöõ chuoät traùi vaø veõ thaønh moät ñöôøng 

troøn nhö hình 4a > Nhaäp baùn kính ñöôøng 

troøn vöøa veõ laø 10 vaøo oâ phía traùi maøn hình 

nhö hình 4b > xong, nhaán daáu tick () treân 

hoäp thoaïi Circle beân traùi maøn hình > choïn 

Sketch ôû phaàn ñaàu beân traùi cuûa thanh 

Command Manager ñeå thoaùt leänh veõ. 

 

 

 

 

 

ii/ Nhaáp chuoät traùi choïn Top Plane treân 

thanh Feature Manager Design tree phía 

traùi maøn hình nhö hình 5a > Nhaáp choïn 

daáu muõi teân (Normal To) treân thanh coâng 

cuï Standard View > Maøn hình laøm vieäc lập 

töùc xoay moät goùc 900 (luùc naøy, neáu coù veõ thì 

caùc neùt veõ seõ vuoâng goùc vôùi maët phaúng ñaõ 

veõ ôû phaàn tröôùc > Choïn Sketch ôû phaàn ñaàu 

beân traùi cuûa thanh Command Manager > 

Choïn bieåu töôïng hình troøn ( ) treân thanh 

Command Manager > Con troû chuoät seõ trôû 

thaønh caây vieát > Ta ñeå muõi vieát vaøo goác toïa 

ñoä giöõa maøn hình, giöõ chuoät traùi vaø veõ 

thaønh moät ñöôøng troøn > Nhaäp baùn kính 

ñöôøng troøn vöøa veõ laø 10 vaøo oâ phía traùi 

maøn hình nhö trình baøy ôû phaàn tröôùc > 

xong, nhaán daáu tick () treân hoäp thoaïi 

Circle beân traùi maøn hình > Nhaáp choïn 

Sketch ôû phaàn ñaàu traùi cuûa thanh Com-

mand Manager ñeå thoaùt leänh veõ.  

Keát quaû cuoái cuøng cuûa böôùc veõ naøy laø 

ñöôøng troøn cuõng gioáng nhö hình 4a, nhöng 

neáu ta giöõ chuoät giöõa vaø keùo ñeå xoay maøn 

hình laøm vieäc thì ta ñöôïc hình troøn (1) vaø 

(2) naèm trong hai maët phaúng vuoâng goùc 

nhau nhö hình 5b.  

Theo toaùn hoïc, neáu ta cho hình troøn (1) 

queùt xung quanh hình troøn (2) thì ta seõ 

ñöôïc hình caàu. 

iii/ Nhaáp chuoät traùi choïn Features ôû phía 

döôùi cuûa thanh Command Manager > Choïn 

Swept Boss/Base cuûa thanh Command 

Manage > Choïn rìa voøng troøn (1) ôû hình 5b > 
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Choïn tieáp vaøo oâ 2 cuûa hoäp thoaïi Sweep nhö 

hình 6a > Tieáp theo nhaáp choïn voøng troøn thöù 

(2) cuûa hình 5b > SolidWokrs seõ veõ hình caàu 

nhö hình 6b > Nhaáp choïn daáu tick () treân 

hoäp thoaïi Sweep keát thuùc leänh veõ hình caàu. 

 

 

 

 

 

 

 

 

 

 

 

 

Böôùc 2: Veõ daây treo cho con laéc 

i/ Nhaáp chuoät traùi choïn Top Plane treân 

thanh Feature Manager Design tree phía 

traùi maøn hình > Choïn daáu muõi teân (Normal 

To) treân thanh coâng cuï Standard View, 

maøn hình laøm vieäc lập töùc xoay moät goùc 

900  > Choïn Sketch ôû phaàn ñaàu traùi cuûa 

thanh Command Manager > Choïn bieåu 

töôïng hình troøn ( ) treân thanh Command 

Manager > Con troû chuoät seõ trôû thaønh caây 

vieát > Ta ñeå muõi vieát vaøo taâm hình caàu, giöõ 

chuoät traùi vaø veõ thaønh moät ñöôøng troøn nhoû 

phía trong hình caàu nhö hình 7a > Nhaäp 

baùn kính ñöôøng troøn vöøa veõ  laø 1 vaøo oâ phía 

traùi maøn hình nhö hình 7b > xong, nhaán 

daáu tick () treân hoäp thoaïi Circle beân traùi 

maøn hình > Choïn Sketch ôû phía ñaàu traùi 

cuûa thanh Command Manager ñeå thoaùt 

leänh veõ. 

 

 

 

 

 

 

 

ii/ Nhaán chuoät traùi choïn Sketch 3 treân 

thanh Feature Manager Design tree phía 

traùi maøn hình nhö hình 8a > Choïn 

Features ôû phía döôùi cuûa thanh Command 

Manager > Choïn theû Extruded Boss/Base 

cuûa thanh Command Manage > Nhaäp soá 

200 vaøo oâ troáng nhö hình 8b > Choïn daáu 

tick () treân hoäp thoaïi Extrude ôû hình 8b 

ñeå keát thuùc leänh veõ daây treo con laéc.  

Neáu ta giöõ chuoät giöõa vaø keùo ñeå xoay 

maøn hình laøm vieäc thì ta ñöôïc con laéc nhö 

hình 8c. 
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Böôùc 3: Veõ voøng treo cuûa con laéc 

Voøng treo laø moät taám hình troøn baùn 

kính trong 3mm, baùn kính ngoaøi 6 mm, 

chieàu daøy 4mm. 

i/ Nhaáp chuoät traùi choïn Top Plane treân 

thanh Feature Manager Design tree phía 

traùi maøn hình > Choïn daáu muõi teân (Normal 

To) treân thanh coâng cuï Standard Views, 

maøn hình laøm vieäc lập töùc xoay ñeå con laéc 

naèm thaúng ñöùng (coù theå choïn Normal To 

nhieàu laàn ñeán khi con laéc naèm thaúng ñöùng 

thì thoâi) > Choïn Sketch ôû phaàn ñaàu beân 

traùi cuûa thanh Command Manager > Choïn 

bieåu töôïng hình troøn treân thanh Command 

Manager > Con troû chuoät seõ trôû thaønh caây 

vieát > Ta ñeå muõi vieát vaøo taâm cuûa ñaàu daây 

treo, veõ caùc hình troøn baùn kính 3 vaø 6 nhö 

hình 9a (coù theå laên chuoät giöõa ñeå phoùng to/ 

thu nhoû hình cho deã veõ). Xong, nhaán daáu 

tick () treân hoäp thoaïi Circle beân traùi maøn 

hình ñeå keát thuùc leänh veõ hình troøn > Choïn 

Sketch ôû phaàn ñaàu beân traùi cuûa thanh 

Command Manager ñeå thoaùt leänh veõ.  

 

 

 

 

 

 

 

 

 

 

 

ii/ Choïn Sketch 4 treân thanh Feature 

Manager Design tree phía traùi maøn hình > 

Choïn Features ôû phía döôùi cuûa thanh 

Command Manager > Choïn Extruded 

Boss/Base treân thanh Command Manager > 

ÔÛ hoäp thoaïi Extruded phía traùi maøn hình, 

nhaäp soá 2 vaøo oâ troáng cuûa phaàn Direction 1, 

nhaäp tieáp soá 2 vaøo oâ troáng cuûa phaàn 

Direction 2 nhö hình 9b > Choïn daáu tick 

() treân hoäp thoaïi Extruded ñeå keát thuùc 

leänh veõ. 

 iii/ Theo caùch veõ treân thì loã voøng treo 

coøn moät ñoaïn daây treo dö nhö hình 9c. Ta 

caét boû ñoaïn dö naøy nhö sau: 

Choïn maët phaúng 1 nhö hình 10a < 

Choïn daáu muõi teân (Normal To) treân thanh 

coâng cuï Standard Views > Maøn hình laøm 

vieäc lập töùc xoay ñeå con laéc naèm trong maët 

phaúng 1 (coù theå laên chuoät giöõa ñeå phoùng to/ 

thu nhoû hình veõ) > Choïn Sketch ôû ñaàu beân 

traùi cuûa thanh Command Manager > Choïn 

bieåu töôïng hình troøn treân thanh Command 

Manager > Con troû chuoät seõ trôû thaønh caây 

vieát > Ta ñeå muõi vieát vaøo taâm cuûa ñaàu daây 

treo, veõ hình troøn baùn kính 3 nhö hình 

10b, xong nhaán daáu tick () treân hoäp thoaïi 

Circle beân traùi maøn hình > Choïn Sketch ôû 

phaàn giöõa cuûa thanh Command Manager ñeå 

thoaùt leänh veõ.  

 

 

 

 

 

 

 

iiii/ Choïn Sketch 5 treân thanh Feature 

Manager Design tree phía traùi maøn hình > 

Choïn Features ôû phía döôùi cuûa thanh 

Command Manager > Choïn Extruded Cut 
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cuûa thanh Command Manage > ÔÛ hoäp thoaïi 

Extrude phía traùi maøn hình, choïn Through 

All trong thanh cuoän Blind nhö hình 11a > 

Choïn daáu tick () treân hoäp thoaïi Extrude 

ñeå thöïc hieän leänh caét boû phaàn daây dö cuûa 

voøng treo. Keát quaû ñöôïc nhö hình 11b. 

 

 

 

 

 

 

 

 

iiiii/ Ta caàn toâ maøu ñeå hình veõ sinh 

ñoäng hôn. Muoán toâ maøu boä phaän naøo thì ta 

nhaáp chuoät traùi vaøo boä phaän ñoù. Nhaáp 

chuoät traùi vaøo daây treo cuûa con laéc >  

SolidWorks môû ra hoäp thoaïi nhoû > Choïn 

Appearance (nuùt hình caàu) treân hoäp thoaïi 

naøy > Choïn tieáp Extrude 2 nhö hình 12a > 

Beân traùi maøn hình xuaát hieän baûng 

Appearace > Keùo thanh cuoän xuoáng döôùi, ta 

choïn maøu toâ phuø hôïp nhö hình 12b > Choïn 

daáu tick () treân baûng Appearace ñeå thöïc 

hieän leänh toâ maøu cho daây treo. Töông töï 

nhö vaäy, ta coù theå toâ maøu heát cho toaøn boä 

caùc chi tieát cuûa baûn veõ. 

Tôùi ñaây ta ñaõ veõ xong con laéc, daây treo vaø 

voøng treo. Ta löu baûn veõ naøy vaøo maùy tính. Ví 

duï, ta löu vaøo thö muïc D/con lac don.  

2.3. Veõ choát treo coá ñònh cuûa con 

laéc ñôn 

Laëp laïi caùch chuaån bò baûn veõ môùi nhö 

trình baøy ôû muïc 2.1. 

i/ Töø maøn hình saün saøng veõ nhö trình 

baøy ôû muïc a, ta choïn bieåu töôïng hình troøn 

treân thanh Command Manager > Con troû 

chuoät seõ trôû thaønh caây vieát > Ta ñeå muõi 

vieát vaøo goác toïa ñoä giöõa maøn hình, giöõ 

chuoät traùi vaø keùo thaønh moät ñöôøng troøn > 

Nhaäp baùn kính ñöôøng troøn vöøa veõ laø 3 vaøo 

oâ phía traùi maøn hình nhö trình baøy ôû caùc 

phaàn tröôùc, xong nhaán daáu tick () treân 

hoäp thoaïi Circle beân traùi maøn hình > Choïn 

Sketch phía beân traùi thanh Command 

Manager ñeå thoaùt leänh veõ. 

 

 

 

 

 

 

 

ii/ Choïn Sketch 1 treân thanh Feature 

Manager Design tree phía traùi maøn hình > 

Choïn Features ôû phía döôùi cuûa thanh 

Command Manager > Choïn Extruded 

Boss/Base cuûa thanh Command Manager > 

ÔÛ thoaïi Extrude phía traùi maøn hình, nhaäp 

soá 6 vaøo oâ troáng nhö hình 13a > Choïn daáu 

tick () treân hoäp thoaïi Extrude ñeå keát thuùc 

leänh. Keát quaû, ta ñöôïc khoái truï baùn kính 3 

mm, daøi 6 mm nhö hình 13b. 
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iii/ Choïn maët phaúng 1 nhö hình 14a < 

Choïn daáu muõi teân (Normal To) treân thanh 

coâng cuï Standard Views > Maøn hình laøm 

vieäc lập töùc xoay veà maët phaúng 1 (coù theå 

laên chuoät giöõa ñeå phoùng to / thu nhoû hình 

veõ) > Choïn nuùt Sketch ôû phaàn giöõa cuûa 

thanh Command Manager > Choïn bieåu 

töôïng hình troøn treân thanh Command 

Manager > Con troû chuoät seõ trôû thaønh caây 

vieát > Ta ñeå muõi vieát vaøo taâm hình troøn 

cuûa khoái truï, veõ hình troøn baùn kính 8 nhö 

hình 14b, xong nhaán daáu tick () treân hoäp 

thoaïi Circle beân traùi maøn hình > Choïn 

Sketch ôû phaàn giöõa cuûa thanh Command 

Manager ñeå thoaùt leänh veõ. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

iiii/ Choïn Sketch 2 treân thanh Feature 

Manager Design tree phía traùi maøn hình > 

Choïn Feature ôû phía döôùi cuûa thanh 

Command Manager > Choïn Extruded 

Boss/Base cuûa thanh Command Manager. ÔÛ 

hoäp thoaïi Extrude phía traùi maøn hình, 

nhaäp soá 6 vaøo oâ troáng nhö hình 15a. Choïn 

daáu tick () treân hoäp thoaïi Extrude ñeå keát 

thuùc leänh veõ khoái truï baäc, ta toâ maøu cuûa truï 

baäc naøy nhö hình 15b. 

3. Laép gheùp con laéc ñôn 

Ta caàn laép con laéc ñôn vaøo choát treo coá 

ñònh. 

Böôùc 1: Môû file laép gheùp môùi 

i/ File > New > Xuaát hieän baûng New 

SolidWorks Document nhö hình 16a. 

 ii/ Choïn Assembly > OK > Xuaát hieän 

maøn hình laøm vieäc môùi, beân traùi maøn hình 

coù hoäp thoaïi Begin Assembly nhö hình 16b. 

Trong hoäp thoaïi hình 16b, ta thaáy coù teân 2 

file “chot treo co dinh” vaø “con lac”. 

 

 

 

 

 

 

 

Hình 16 

Böôùc 2: Ñöa caùc chi tieát ra maøn hình  

Laøm töông töï nhö treân ñoái vôùi chi tieát 

“con lac”, ta ñöôïc nhö hình 17. 
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Böôùc 3: Thöïc hieän laép gheùp 

i/ Choïn nuùt Mate treân thanh Command 

Manager, phía traùi maøn hình xuaát hieän hoäp 

thoaïi Mate nhö hình 18a > Choïn maët truï (1) 

cuûa chi tieát “chot treo co dinh”, maët truï naøy 

bieán thaønh maøu xanh nhö hình 18b. Tieáp 

theo, choïn maët truï trong (2) cuûa chi tieát “con 

lac” nhö hình 18c, laäp töùc SolidWorks thöïc 

hieän leänh laøm cho maët truï ngoaøi (1) vaø maët 

truï trong (2) ñoàng taâm nhö hình 18d. 

ii/ Choïn maët (3) vaø maët (4) nhö hình 

19a, laäp töùc, SolidWorks thöïc hieän leänh 

laøm cho maët (3) vaø maët (4) eùp saùt vaøo nhau 

nhö hình 19b. Keát quaû cuoái cuøng cuûa böôùc 

naøy ta ñöôïc con laéc ñôn ñaày ñuû caùc boä phaän 

nhö hình 19c. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Moâ phoûng chuyeån ñoäng cho con 

laéc ñôn 

i/ Laên chuoät giöõa sao cho toaøn boä con 

laéc ñôn naèm vaøo giöõa maøn hình ñeå deã quan 

saùt nhaát.  

ii/ Nhaáp chuoät traùi choïn leänh New 

Motion Study treân thanh Command 

Manager > Phía döôùi maøn hình seõ xuaát 

hieän baûng Animation daøi heát maøn hình nhö 

hình 20a >  Nhaáp chuoät traùi vaøo bieåu töôïng 

ñoäng cô (kyù hieäu ÑC) treân hình 20a > Xuaát 

hieän tieáp beân traùi maøn hình hoäp thoaïi 

Motor  nhö hình 20b. 

iii/ Laên chuoät phoùng to chi tieát con laéc 

ñôn, nhaáp chuoät traùi choïn maët truï (1) nhö 

hình 20c, laäp töùc coù daáu muõi teân cong maøu ñoû. 

iiii/ ÔÛ hoäp thoaïi Motor, nhaáp chuoät traùi 

vaøo thanh cuoän Constant Speed > Choïn theû 

Oscillating, nhaäp giaù trò vaøo hai oâ troáng 

phía döôùi nhö hình 20d (ñieàu naøy cho bieát 
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ta ñaõ thieát laäp cho con laéc ñôn dao ñoäng vôùi 

bieân ñoä goùc laø 100, taàn soá laø 0,5 Hz. Xong, 

nhaáp chuoät traùi choïn daáu tick () treân hoäp 

thoaïi Motor ñeå keát thuùc leänh. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 20

  Ñeå xem laïi moâ phoûng cuûa chuyeån 

ñoäng naøy, ta nhaáp chuoät traùi choïn nuùt Play 

nhö hình 20a. Luùc ñoù, treân maøn hình con 

laéc seõ dao ñoäng raát sinh ñoäng.  

5. Löu file phim moâ phoûng chuyeån 

ñoäng cho con laéc ñôn  

Nhaáp chuoät traùi choïn nuùt Save treân 

baûng Animation hình 20a > Xuaát hieän hoäp 

thoaïi Save Animation to File > nhaäp soá 20 

vaøo oâ Frames per second. 

Ñaët teân file caàn löu vaøo oâ Save in > 

Nhaáp choïn nuùt Save, xuaát hieän tieáp hoäp 

thoaïi Video Compression > Thieát laäp caùc 

giaù trò nhö hình 21 > Nhaáp OK.  

 

 

 

 

 

 

 

Quaù trình löu phim daïng coù ñuoâi (*.avi) 

baét ñaàu. Ñaây laø file phim deã söû duïng nhaát, 

môû baèng Windows media coù saün trong 

Windows. 

 Nhö vaäy, ta ñaõ coù phim moâ phoûng dao 

ñoäng cuûa con laéc ñôn.  
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6. Keát luaän  

Söû duïng phaàn meàm ñoà hoïa SolidWorks 

2009 ñeå veõ, laép gheùp vaø döïng phim moâ 

phoûng chuyeån ñoäng cuûa vaät theå trong 

khoâng gian, giuùp cho giaùo vieân laøm ñöôïc caùc 

phim sinh ñoäng, phuïc vuï ñaéc löïc trong soaïn 

baøi giaûng vaø trình chieáu baèng PowerPoint 

khi giaûng daïy. 

* 

USING SOLIWORKS TO MAKE MONTAGE THAT STIMULATES  

MOVING OBJECTS 

Ngo Bao 

Thu Dau Mot University   

ABSTRACT 

This paper presents a montage that simulates moving objects. It uses SolidWorks 2009 

software for drawing graphic objects and 3-dimensional (3D) objects., The software is also 

used to assemble objects into one multifunction system and make a montage with moving 

objects suitable for teaching physics, chemistry and engineering. To illustrate this, the 

author shows how to create a video simulating the swing of the pendulum. 
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